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1. Introduction 

 
The Executive Office of Environmental Affairs through Massachusetts Coastal Zone 

Management (MACZM) contracted Applied Science Associates (ASA) to generate three-

dimensional (3D) simulations of sea level rise and flood event inundation in an effort to 

enhance hazard mitigation planning, emergency response, and public awareness 

through improved flood visualization products.  This pilot study focuses on seven critical 

facilities in Hull, MA.  Hull has been selected as a StormSmart Coasts pilot community 

and needs to develop support for a freeboard standard in the coastal A zone.  Coastal A 

zones are found adjacent to V zones, and are expected to experience wave action 

between 1.5 and 3 feet. 

 

The 3D models will serve as educational materials for local officials whose support is 

needed for this initiative.  Longer-term goals involve implementation of the 3D modeling 

process by other coastal communities and planning agencies and the use of the models 

in a climate change adaptation initiative.  With this in mind, the project was designed to 

facilitate its implementation in other geographic areas; this technical report outlines the 

details of generating similar 3D models in other coastal communities around the state of 

Massachusetts and presents the challenges and results of the pilot study in Hull, MA.   

 

Applied Science Associates (ASA), working together with subcontractors ESS Group 

and WSP SELLS, used LIDAR and survey data to create 3D models of five flooding 

scenarios at seven critical facilities around Hull.  The facilities and flooding scenarios 

were determined by the entire project team which consisted of representatives of 

MACZM, the town of Hull, ASA, and ESS.  These facilities identified include: 

 

1. Hull High School 

2. Hull Waste Water Pollution Control Facility 

3. Allerton Post Office 

4. Hull Memorial School 

5. Anne M. Scully Senior Center 

6. Draper Ave. Stormwater Pump Station 

7. Hull Municipal Light Plant 

 

The first step in this process, described in Section 2, is to perform a field survey of each 

site.  These surveys serve multiple purposes: (1) provide ground elevations for 

confirming LIDAR data accuracy, (2) provide building corner points for construction of 

building footprints, and (3) provide building heights for constructing three-dimensional 

building models.  ASA used the survey data to confirm the LIDAR accuracy (described in 
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Section 3) and construct two-dimensional building footprints (described in Section 4).  

ESS Group combined building footprints and building height surveys to construct the 

three-dimensional building models (described in Section 4).  Using the LIDAR data and 

the flooding scenarios defined by MACZM, ASA generated the 3D flood layers to overlay 

on the building models. The flooding scenarios defined by the project team include: 

 

1) Base Flood Elevation (BFE), expected elevation of flood waters and wave 

effects during the 100-year flood 

2) BFE + 0.3 m  

3) BFE + 0.5 m  

4) BFE + 1.0 m  

5) BFE + 3.0 m  

  

The building models and flood layers were all converted to KML and linked together for 

visualization in Google Earth.  Ultimately the 3D buildings were also submitted for 

inclusion in the native Google Earth 3D buildings layer.  This process is outlined in 

Sections 5 and 6.    

 

Software products used in this project include: 

 

 ArcGIS Desktop application such as ArcView® 

 Microsoft Office Excel 

 Google™ SketchUp  

 Google™ Earth 

 Text editor such as WordPad 

 Adobe® Photoshop® 

 Web browser such as Internet Explorer® 

 

The following sections describe the process of evaluating LIDAR data, building 3D 

models, creating flood overlays, and migrating all data to Google Earth in detail.   

2. Field Survey of Critical Facilities 

ASA contracted with WSP SELLS to provide the surveys of each critical facility.  The 

surveys are critical to this process because they allow construction of building footprints, 

provide building heights, and allow confirmation of the LIDAR data accuracy.   
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Analysis Steps 
 

Buildings should be surveyed by a professional surveyor.  When requesting field surveys 

ensure: 

 

1. At least one baseline survey is established at each building site at a location from 

which the peak building height is visible. 

 

2. After establishing a baseline at each site, ground elevations are shot at multiple 

locations along the base of the building, including corner points. 

 

3. At least several ground elevations are shot at locations that are clear of foliage 

that may have affected the LIDAR survey values. 

 

4. The horizontal and vertical accuracy are at least as good as the LIDAR accuracy. 

 

5. The height survey includes the peak building height as well as any other roof 

elevations visible from the baseline. 

 

The building survey data was provided to ASA in the format of a comma separated 

values (CSV) file.  This file can be read easily by Microsoft Excel, and with the correct 

header can be ingested directly into ArcView.  

The file was processed using the following steps 

to allow ingestion to ArcMap: 

 

1. Open the survey date with Microsoft 

Excel. 

 

2. Save a copy of the file in .csv format for 

import to ArcView. 

 

3. Delete any excess header information. 

 

4. Ensure that the necessary field headers 

exist and are properly labeled as follows: 

 

a. ID: A unique identifier for each 

survey point. 
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b. X: the easting coordinate of the survey point (in known coordinate system 

such as Mass State Plane). 

 

c. Y: the northing coordinate of the survey point (in known coordinate 

system such as Mass State Plane). 

 

d. Z: the elevation of the survey point (with known vertical datum such as 

NAVD88). 

 

e. Location: name of the facility at which the point was taken. 

 

f. Description: type of point (e.g. “Building Corner Ground Elevation” or 

“Building Height”). 

 

5. Save the file and close Excel. 

 

6. Open Windows Explorer and rename the file with a .txt extension.  Saving a file 

as .txt directly from Excel makes the file tab-delimited, which cannot be read by 

ArcView. 

 

7. Open ArcView and select Add XY Data from the Tools menu. 

 

8. Use the Browse button to navigate to the survey points text file. 

 

9. Set the X and Y fields using the drop-down menus. 

 

10. Set the spatial reference using the Edit button and navigating to the appropriate 

coordinate system. 

 

11. Click the OK button to import the points to ArcView. 

 

12. A temporary feature class will automatically be loaded into the ArcView project.  

Right click on the feature class and choose Data >> Export Data to make a 

permanent copy of the file.  When prompted, load the permanent copy into the 

ArcView project.  The file is now ready to be used for further analysis. 

 

Section 3 outlines how to use the survey points to confirm the LIDAR data accuracy.  

Section 4 details the process of generating two-dimensional building footprints from the 

survey points. 
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Pilot Study Results 
 

WSP SELLS provided multiple survey points, in text file format.  The original file was 

delivered with a long header describing the metadata, a header describing each field, 

and individual headers separating the points from each facility.  The survey points in the 

file represented both ground elevations and building heights at each of the seven critical 

facilities for a total of 101 survey points.  Of these points, 73 provided ground elevations 

useful for the statistical comparison of surveyed and LIDAR points, 45 provided building 

corner locations and ground elevations useful for delineating building footprints and 23 

provided building heights useful for constructing three-dimensional building models from 

the two dimensional footprints.  Once imported into ArcView, following the steps in 

Section 3, it became clear that one of the Draper Avenue Pump Station building corner 

points was mis-located.  This point was thrown out, leaving 44 points providing building 

corner points and 72 points providing ground elevations. 

 

The file contained fields for X, Y, and Z position as well as facility name and point 

description.  Table 2.1 summarizes the descriptions and the use of each category in the 

pilot study. 

 

 

Table 2.1 Summary of Building Survey Points 

Pilot Study Use Point Description 

Ground Elevation 

Building Corner Ground Elevation 

Building Corner Ground ElevationG 

Drill Hole in Hole in Concrete Walk  

Ground Elevation 

PK Nail in Pavement 

Building Height 

Building Height 

Building Height_Tallest Point  

Flat Roof 

Flat Roof_Tallest Point 

Peak of Sloped Roof 

Peak of Sloped Roof-R 

Peak of Sloped Roof_Tallest Point 

Spire-R 

Spire-R_Tallest Point 

Top of Parapet Wall 

Top of Parapet Wall_Tallest Point 
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3. LIDAR Statistical Analysis 
 
To use the survey points for confirming LIDAR data accuracy, they must be filtered so 

that they contain only ground elevation data.  Once filtered, each point should be 

associated with the LIDAR elevation at the same location.  To confirm the LIDAR 

dataset’s accuracy a statistical analysis should be performed on the differences between 

the surveyed and the LIDAR elevations. To prepare the data and perform the statistical 

analysis: 

 

Analysis Steps 
 

1. Open ArcView and load the feature class 

containing the surveyed points 

(generated by following the steps in 

Section 2). 

 

2. Open the attribute table by right-clicking 

the layer name in ArcView’s Table of 

Contents and choosing Open Attribute 

Table. 

 

3. Determine which points represent ground 

elevations by using the Description field.  

If necessary contact the surveyor to 

confirm which points represent ground 

elevations. 

 

4. From the attribute table’s Options drop-

down menu, choose the Select by 

Attributes tool. 

 

5. In the Select by Attributes dialog, create a query to select all features 

representing the ground elevation points using the Description field. 

 

6. With the ground elevation points selected, close the attribute table, right-click on 

the feature class and choose Data >> Export Data to save a copy of the selected 

features as a new feature class.  When prompted load the new feature class into 

the ArcView project and remove the original survey points file by right-clicking on 

the layer name and selecting Remove.   
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7. Load the bare earth LIDAR grid(s) into the ArcView project. 

 

8. Load ArcToolbox by clicking the toolbox button, , and open the Extract 

Values to Points tool from the Spatial Analyst Tools > Extract toolbox. 

 

a. Set Input Point Features equal to the ground elevation points feature 

class. 

 

b. Set the Input Raster equal to the bare earth LIDAR elevation grid. 

 

c. Set the output path and file name. 

 

d. Click the OK button. 

 
 

e. A new point feature class will be created.  This feature class will contain a 

new field with the LIDAR data elevations.  Each point will be assigned the 

elevation from the LIDAR cell directly below it. 

 

9. Repeat steps 8a to 8e for each LIDAR dataset that overlaps the survey points.  

This will create a separate point shapefile for each LIDAR dataset. 

 

10. If multiple datasets with LIDAR elevations 

were created in step 9, use the Merge 

tool from ArcToolbox (in the Data 

Management Tools > General toolbox) to 

combine them into a single feature class. 
 

a. In the Merge dialog, use the Input 

Datasets drop down menu to add 
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all survey point layers to the Input Datasets list.   

 

b. Set the output name and location of the merged file and click OK. 

 

11. Open the attribute table of the ground elevation feature class.  It should contain 

one field for the surveyed elevation and one field for the associated LIDAR 

elevation.   

 

12. Click the Options button and choose the Export option. 

 

13. In the Export dialog, use the browse button to save the attribute table as a DBF 

file. 

 

14. Open the DBF file with Excel and save it as an Excel file. 

 

15. Create a new column and set it equal to the difference between the survey and 

LIDAR elevations. 

 

16. Calculate basic statistics from the elevation differences, including mean, 

minimum, maximum, and standard deviation. 

 

17. Check whether the elevation differences follow a normal distribution by using 

standard statistical methods (e.g. the Chi-Squared Test).  

 

a. If the elevation differences are normally distributed, calculate the Root 

Mean Square Error (RMSE).  The vertical accuracy of the LIDAR data at 

a 95% confidence interval is equal to RMSE * 1.96 (FGDC, 1998).  

 

b. If the elevation differences are not normally distributed, the vertical 

accuracy at the 95% confidence interval is equal to the 95th percentile 

error for all survey points (North Carolina Cooperating Technical State 

Flood Mapping Program, 2008). 
 

18. Compare the computed vertical accuracy with the stated vertical accuracy of the 

LIDAR dataset. 
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Pilot Study Results 
 
For the Hull pilot study, the field survey provided 72 ground elevation points.  Each of 

these points was assigned an LIDAR elevation in addition to the Z value provided by the 

survey team.  The differences between the survey and LIDAR elevations were 

calculated and used to determine basic statistics and vertical accuracy.  Using the 

Kolmogorov-Smirnov Test and the Chi-Square Test, it was found that the differences in 

elevations between the LIDAR and surveyed points are not normally distributed.  The 

elevation differences were then matched against a variety of distributions until the best 

fit, a lognormal distribution, was found.  That the elevation differences are lognormally 

distributed was confirmed using the Kolmogorov-Smirnov and Chi-Square tests with a 

5% significance level. 

 

Since the data are not normally distributed, the vertical accuracy was determined using 

the percentile error method outlined in step 15b.  The vertical accuracy at a 95% 

confidence interval is 17 cm, which is better than the stated vertical accuracy of 30 cm.  

A statistical summary of the differences between the surveyed and LIDAR elevations is 

provided in Table 3.1. 

 

 
Table 3.1: Summary Statistics of Elevation Differences 

Descriptive Statistics (m)  

Maximum  0.36  

Minimum  0.004  

Mean  0.07  

Std. Deviation 0.07  

RMSE  0.10  

95% Percentile  0.17  

68% Percentile  0.07  
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4. Constructing Building Models 

During the early phases of the pilot project seven critical facilities were identified to 

provide context to the inundation visualizations.  Using the survey results and photos of 

the facilities, 3D building models were constructed. The purpose of this analysis is to 

show the depth of flooding for each combination of BFE and sea level rise at each 

structure.  Generating three dimensional models of each facility is a crucial step to 

visualizing inundation because the models provide the viewer with a baseline against 

which to judge the flood depths.  Realistic 3D model building involves three major 

components (1) generating two-dimensional (2D) building footprints from plans, surveys, 

or measurements (2) constructing walls and rooflines and (3)adding textures from actual 

photographs of the structures.  These steps are outlined below. 

 

Analysis Steps 
The first step to building 3D models is to create the 2D building footprints.  This step is 

only necessary if building plans are not available.  For the pilot project plans were not 

immediately available and 2D footprints were created.   

 
Creation of 2D Building Footprints 

 
A combination of the building corner survey points, high resolution orthophotos, 

downloaded from MassGIS, and first-return LIDAR data was used to create the building 

footprints.  Building footprint data has already been extracted from LIDAR data for 33 

towns in the metro-Boston area.  If building footprints already exist, then the steps 

described here for creating them can be skipped.  Once created, the building footprints 

can be used to define building dimensions in SketchUp providing the base upon which 

the photorealistic 3D models of the facilities are built. 
 
 

1. Create a shapefile to store the 2D building 

footprints: 

 

a. Open ArcCatalog and browse to 

the project working folder. 

 

b. Right-click in the Contents window 

and choose New > Shapefile. 

 

c. Give the shapefile a meaningful 

name. 
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d. Set the Feature Type to Polyline – the footprints will be constructed of 

polylines and then converted to polygons. 

 

e. Set the desired Spatial Reference using the Edit button (the pilot study 

used to NAD 1983, Massachusetts State Plane). 

 

f. Click OK to create the shapefile. 

 

2. Open ArcView and load the empty 2D footprints shapefile 

 

3. Load the feature class containing the surveyed points (generated by following the 

steps in Section 2). 

 

a. Open the attribute table by right clicking the layer name in ArcView’s 

Table of Contents and choosing Open Attribute Table. 

 

b. Determine which points represent building corners by using the 

Description field.  For the pilot study in Hull, building corner points 

included all variations of “Building Corner Ground Elevation” 

 

c. From the attribute table’s Options drop-down menu, choose the Select by 

Attributes tool. 

 

d. In the Select by Attributes dialog, create a query to select all features 

representing the building corner points using the Description field. 

 

e. Close the attribute table, right-click on the feature class and choose Data 

>> Export Data to save a copy of the selected features as a new feature 

class.  When prompted load the new feature class into the ArcView  

project and remove the original survey points file by right-clicking on the 

layer name and selecting Remove.   

 

4. If available, load the first return LIDAR grid(s) to the project.  These grids provide 

the elevation of the highest reflective object that each LIDAR pulse encounters 

and are useful in delineating building footprints. 

 

5. Load high resolution ortho imagery: 

 

a. Open an internet browser and go to the MassGIS data index website. 
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b. From the list of Ortho Imagery, determine the highest resolution imagery 
available in the area of interest.   

 
i. For all coastlines north of Cape Cod use the USGS Color Ortho 

Imagery (2008) dataset.   
 

ii. For the Cape Cod, Buzzards Bay, and Narragansett Bay 
shorelines, use the 1: 5000 Color Ortho Imagery (2005) dataset. 

 
c. Download the relevant tiles (each dataset will provide a link to an index 

map which can be used to identify the necessary tiles) ensuring that all 

three files (.sid, .sdw, .sid.aux.xml) with the same name as the tile index 

are downloaded.  

 

d. Load the ortho imagery files into the ArcView project 

 

6. Create the 2D building footprints 

 

a. Overlay the survey points on top of the first return LIDAR and/or the ortho 

imagery to help trace in the building outlines.  Depending on the survey 

extent, only two sides of the building may be represented with survey 

points. These sides will be drawn first; the remaining sides will be drawn 

with the assistance of the LIDAR data and ortho imagery.  Note that the 

survey points may not appear to line-up with the imagery as the building 

roof may obscure the base, as shown below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

b. Start editing the empty 2D footprint shapefile by selecting Start Editing 

from the Edit menu.  If prompted, make sure to choose the correct source 

folder for the edits. 

 

Survey Points on Ortho Imagery Survey Points on First Return LIDAR
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c.  Choose Snapping from the Edit menu and check-on Vertex, Edge, and 

End snapping for the survey points layer and the 2D Footprint lines layer.  

 

d. Using the Editor’s Sketch Tool, , connect the survey points along the 

base of the building, making sure to snap the endpoints to the survey 

points.  Use the LIDAR and orthophotos to digitize any features missed 

by the survey such as the jogs 

in the Hull Memorial School 

façade, visible aerially in the 

images above.  

 

e. Once the surveyed sides of 

the building have been drawn.  

Use the Copy Parallel tool, 

available from the Editor 

menu, to create the remaining 

building walls.  Use the editor’s 

Edit tool, , to drag-and-drop 

the lines into place and snap the endpoints together.  

 

f. After creating all the walls, choose Editor > Save Edits and then Editor > 

Stop Editing to finalize the shapefile. 

 

7. Convert the footprint polylines to 

polygons using ETGeoWizards, which 

can be downloaded from: 

http://www.ian-ko.com/.   

 

a. Follow the ETGeoWizards 

installation instructions and 

then open the tool in ArcView. 

 

b. From the ETGeoWizards 

Convert tab, choose the 

Polyline to Polygon tool and click GO. 

 

c. Follow the instructions in the Wizard to 

create a polygon shapefile of the 

building footprint polylines. 
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d. If you cannot download ETGeoWizards, use ArcCatalog to create a new 

polygon shapefile (as in Step 1) and using the Editing tools to create a 

polygon by tracing the footprint polylines. 
 
 
 
Extraction of 3D Building Models 

 
The 3D models for the Hull pilot study were produced using a combination of software 

packages and different techniques.  In general, 2D building foundations were created 

using measurements from existing site plans and field data collected by survey crews. 

SketchUp was then used to extrude these 2D foundations and create a basic 3D model 

of each building.  Once the base model was completed, field photos of each building 

were used to texture the exterior of the 3D buildings giving the models a realistic 

representation.  The final models were then georeferenced using the Google Earth 

controls in SketchUp.  Finally, the models were uploaded to Google™ 3D Warehouse for 

public distribution and approval into Google Earth’s 3D Buildings layer.  

 

Use the steps below to create 3D building models using SketchUp and Google Earth. 

Remember, each building is different and can pose unique challenges, for more 

information about building 3D models see Google’s Modeling Guide. 

 

1. Obtain Photos and Building Heights: 

 

a. Perform a site visit to each building and take photographs of all the faces 

of each building.   

 

b. Ideal photos are taken perpendicular to the face of the building.   

 

c. Obtain heights of any features not surveyed during the survey process.  

ESS used a TruPulse™ 360 Laser Rangefinder to supplement the 

building heights taken by the survey crew. 

 

2. Create a building base in SketchUp: Depending on the complexity of the building, 

site plans/blueprints may not be needed to create the 2D foundation of the 

model.  Simple length measurements on a rectangular building are easy to obtain 

(e.g. from the 2D footprints created above) and can provide the base data 

needed for the foundation.  However, with more complex buildings, blueprints 

provide more detailed information which facilitates the process of building a 

foundation.  ESS used both techniques for the development of the models.  
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a. Open SketchUp (download and install if necessary) 

 

b. Load the Views toolbar (View > Toolbars > Views). 

 

c. Switch the view to Plan view by pressing the Top button, , on the Views 

toolbar. 
 

d. Load the building blue-prints, if available, and scale according to the 

dimensions of the site plan  

 

i. Load the blueprint image (File > Import) 

 

ii. Click and place the image roughly where the 

XYZ planes meet on the screen and drag the 

image to the approximate size of the building 

dimensions. 

 

iii. Scaling at this stage is a very rough estimate so use the Tape 

Measure Tool, ,  to verify the blueprint dimensions are correct 

and use the Scale Tool, , to adjust the image as necessary by 

dragging the outer nodes. 

 

e. Once the blueprints are scaled, draw the base of the building using the 

Line tool, . Trace the building footprint by drawing a line and entering 

the line length in the dimension length window.   Double-click to complete 

each polygon.   Buildings with varied heights should have individual 

shapes for each different height. 

 

f. If no blueprints are available, either use Google Earth to obtain 

dimensions by zooming into the building of the model at an eye altitude of 

roughly 200ft and using the Ruler Tool to derive the dimensions of the 

building footprint or use the 2D shapefile footprints created in the section 

above to determine the building dimensions.  Once the building 

dimensions have been determined draw the foundation lines as described 

in Step e. 

 

3. Building the 3D Model: once the 2D footprint is 

created in SketchUp and all necessary building 

heights have been collected, the footprint can 
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be extruded to the correct height using the Push/Pull tool. 

 

a. Switch to an oblique view of the building by clicking the Iso icon, , 

found on the Views toolbar. 

 

b. Select the Push/Pull tool, , click on the object to be extruded, type in 

the height (in meters),  and press Enter.  The object will now be extruded 

to the specified height. 

 

i. The Tape Measure Tool, , can be used to verify heights and 

distances between features by clicking on the endpoints of the 

building. 

 

c. Since no data were available on roof angles, the rooflines were rendered 

from field photographs and height measurements. 

 

i. Depending on the roof type, roofs can be created two ways: 

 

1. For flat roofs: by extruding an overlapping, slightly larger 

polygon to the proper dimensions for the roof;  

 

2. For peaked roofs: by dividing the roof top using the Line 

tool, , and using the Move Tool, , to raise or lower the 

line to the proper peak height. 

 

4. Editing the Field Photos: the photographs taken during the field survey contain 

elements such as vegetation and vehicles that obscure the exterior faces of the 

buildings.  These features must be removed from the photos to create realistic 

depictions of the facilities 

 

a. Open each field photograph in an image editing software program.  The 

pilot project team used Adobe Photoshop.   

 

b. Select and erase any element that obscures the 

building façade 

 

c. To fill in the empty spaces, select and copy similar 

components from other areas of the photo and paste them into the empty 

areas 
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d. Adjust tones as necessary to achieve a uniform appearance. 
 

e. Resize the image to 512 pixels along the shorter axis; this will help to 

control the file size of the final 3D model. 

 

5. Using the Field Photos for Texture: the modified photos can now be used to add 

texture to the walls of the 3D models in SketchUp. 

 

a. Open the Paint Bucket tool, , by clicking on the icon. 

 

b. In the Paint Bucket dialog, choose the Create Material tool 

 

 

 

 

 

 

c. In the Create Material dialog, in the  

Texture section, select Use Texture Image, 

and navigate to the image to be imported.  

Repeat this process for each photo to be 

imported. 

 

 

 

 

 

 

 

 

 

d. Apply the imported textures to building faces  

 

i. In the Materials window, highlight the texture to be used.  

 

ii. Click on a face on the model to place the texture on the face. 

 

1. This image can be stretched using the Position Texture 

Tool, .   Access the tool by right-clicking on the image 

and selecting Texture > Position.    

Create Material Tool
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2. To position the image to match the model, drag the tool’s 

pinpoints to the corners of the corresponding building face. 

   

3. Once the image is positioned correctly on the face, right 

click on the image and select Done.   

 

4. Finally, right click on the image and select Make Texture 

Unique.  This step crops the photo to the building edges, if 

necessary and helps to reduce the final file size. 

 

e. To reduce the file size of the model, select Purge Unused images from 

the Materials window by clicking on the Details, , button.   

 

6. Placing the Model: when the model is completed it needs to be placed in a 

geographically correct position in order to be viewed in Google Earth.  The link 

between SketchUp and Google Earth facilitates this process.  ESS used survey 

data as well as the Google Earth base orthophotos to place the models correctly 

in Google Earth. 

 

a. Open Google Earth and zoom to the location of the building. 

 

b. Open the SketchUp building model and load the Google toolbar (View 

menu > Toolbars > Google). 

 

c. Use the Get Current View tool, , to import a snapshot of the current 

view in Google Earth. 

 

d. Use the Select tool, , to select the entire 

model. 

 

e. Use the Move, , and Rotate, , tools to 

adjust the model to fit over the Google Earth 

image of the building.   

 

f. Once located correctly, use the Place Model 

tool,  , on the Google Toolbar to export the 

model to Google Earth.  View the model in 

Google Earth to ensure accuracy. 
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7. Publishing the Models to Google Earth: while placing the model in Google Earth, 

as described in Step 6, creates a KML version of the model that can be opened 

in Google Earth by the user, it does not publish the model to 3D Warehouse or 

add the model to the native Google Earth 3D buildings layer.  Due to a bug in the 

Google Earth software, in order for the transparent flood overlays created in the 

next step to display correctly, the 3D building models must be accepted by 

Google for public distribution in the native 3D buildings layer. 

 

a. Once the 3D model is completed in SketchUp, go to File > 3D Warehouse 

> Share Model.  The user will be prompted to login to a Google account.  

If necessary, create a Google account here.  

 

b. The user will be prompted for information about the model including 

model title, address, description, etc.  Once completed click on the 

Upload button. 

 

c. The Google review process can take up to 30 days. Periodically check 

your account to see if the model has been accepted or check the 3D 

Building layer in Google Earth to see if your model appears.  If the model 

is not accepted, Google will give you a brief description of the edits 

necessary for acceptance. 

 

Pilot Study Results 
 
Seven critical facilities around Hull were chosen for the pilot study.  These facilities were 

chosen during the initial planning meeting of the project team which included 

representatives from MACZM, the town of Hull, ASA, and ESS.  The locations chosen 

are all public buildings and are well dispersed throughout the town (Figure 4.1).  The 

facilities, addresses, and corner elevations are summarized in Table 4.1. 
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Table 4.1. Hull critical facilities and addresses. 

 

Facility Address 

Elevation 

NW 

(m NAVD 88)

Elevation 

NE        

(m NAVD 88)

Elevation  

SE        

(m NAVD 88) 

Elevation 

SW       

(m NAVD 88)

Hull High School 180 Main Street 3.55 2.99 2.82 3.20 

Hull Memorial 

School 

81 Central Avenue 

2.58 3.73 3.85 2.39 

Waste Water 

Treatment Facility 

1111 Nantasket 

Avenue 3.10 3.04 3.37 3.26 

Anne M. Scully 

Senior Center 

197 Samoset Avenue 

2.89 2.89 2.89 3.16 

Allerton Post 

Office 

797 Nantasket 

Avenue 2.78 3.25 3.22 2.95 

Draper Ave Pump 

Station  

200 Newport Avenue 

1.67 1.74 2.03 1.96 

Municipal Light 

Plant  

15 Edgewater Road 

5.24 4.67 3.16 3.44 
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Figure 4.1. Critical facilities used for flood visualizations. 

 

 
Initially 2D footprints of each building were constructed using the survey points, 

orthophotos, and first return LIDAR datasets.  Screen shots of these footprints are 

shown in figure 4.2 through 4.8. 
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Figure 4.2. Two-dimensional model of Allerton Post Office. 

 

 

 

 

 

 

 

 
 
 
 
 
 

 
 
 
 

 
Figure 4.3. Two-dimensional model of the Waste Water Pollution Control Facility. 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.4. Two-dimensional model of Hull High School. 
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Figure 4.5. Two-dimensional model of Hull Municipal Light Plant. 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 4.6. Two-dimensional model of the Anne M. Scully Senior Center. 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.7. Two-dimensional model of the Hull Memorial School. 
 



2009-085 / Inundation Visualization 

 26

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 4.8. Two-dimensional model of the Draper Avenue Stormwater Pumping Station. 

 

All seven 3D models have been completed in SketchUp and to date all but the Draper 

Avenue Pump Station have been accepted into the native Google Earth 3D Buildings 

layer.  The 3D Warehouse Links to the models used for this project are listed below: 

 

1. Allerton Post Office 

2. Hull Waste Water Pollution Control Facility  

3. Hull High School 

4. Hull Municipal Light Plant 

5. Anne M. Scully Senior Center 

6. Hull Memorial School 

7. Draper Avenue Stormwater Pumping Station 

 

Several of the models required tweaking before they were accepted by Google Earth.  

The project team experienced issues with model file size, terrain conflicts, z-fighting, and 

number of structures as summarized in Table 4.2.  General acceptance criteria for 

Google Earth models is available here. 
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Table 4.2. Summary of Google’s feedback for the 3D models.  

Facility Issue  Solution 

Hull High School 

Hull Memorial School 

File Size Reduced file size of texture 

images following techniques 

outlined in the steps above. 

Hull Memorial School 
Z-Fighting Followed Google 

recommendations. 

Municipal Light Plant 

Draper Avenue Pump Station 

Elevation Conflicts Enabled Terrain Mode in 

SketchUp and adjusted models 

as necessary 

Municipal Light Plant 

Model contained 

more than one 

discreet structure 

Removed rear garage 

structures from model. 

 

 

Figures 4.9 through 4.15 show the 3D version of each facility.  These buildings can be 

located in Google Earth using the addresses provided in Table 4.1.   

 

 

 

 

 
Figure 4.9. Three dimensional view of Allerton Post Office. 
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Figure 4.10. Three dimensional view of Hull Waste Water Pollution Control Facility. 

 
 

 
Figure 4.11. Three dimensional view of Hull High School. 

 
 

 
Figure 4.12. Three dimensional view of Hull Municipal Light Plant. 
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Figure 4.13. Three dimensional view of Anne M. Scully Senior Center. 

 
 

 
Figure 4.14. Three dimensional view of Hull Memorial School. 

 

 
Figure 4.15. Three dimensional view of the Draper Avenue Stormwater Pump Station. 
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5. Creating Flood Layers 
 

Analysis Steps 
The creation of flood layers requires two input data sources (1) the flood elevation to be 

simulated and (2) a high resolution elevation dataset.  The process of creating the layers 

involves determining the land area at elevations less than the flood elevation.  Isolated 

low-lying areas, i.e. those not connected to a flooding source, need to be removed from 

the dataset.  The process of creating these layers can largely be accomplished with 

ArcView.  The entire process is described in the steps below. 

 

1. Determine Flood Elevations: for the Hull pilot study, flood elevations were defined 

by using the recently determined (November 2008) Base Flood Elevations (BFE) 

from the Federal Emergency Management Agency (FEMA) Preliminary Digital 

Flood Insurance Rate Map (DFIRM) for Plymouth County plus some amount of 

sea level rise.  Under the FEMA’s Map Modernization and RiskMAP Programs, 

most floodplains are being updated and converted to DFIRM format.  Priority is 

given to coastal flood zones, so be sure to check for the most recent maps 

before proceeding with this process. BFEs will generally be referenced to 

NAVD88, however ensure that this is the case before proceeding. 

 

a.  DFIRMS are available in the format of ESRI personal geodatabases 

(GDB).  These database files contain a suite of spatial and non-spaital 

information including a base map, features such as floodplain boundaries, 

BFEs, floodways, cross sections and bench marks, a digital copy of the 

Flood Insurance Study (FIS), all metadata, and backup engineering data 

(FEMA, 2003). 

 

b. To determine BFE elevations at a particular location, open ArcView and 

load the 2D building footprints and the DFIRM S_FLD_HAZ_A feature 

class (found in the DFIRM geodatabase > DFIRM_MapLayers feature 

dataset).   

 

c. Using ArcView’s zoom tools, 

, zoom into your 

area of interest. 

 

d. Activate the Identify tool, , 

and click on the map near the 

facility to query the BFE. 
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e. The BFE value will be in the the Static_BFE field. 

 

f. Record the BFE at each facility by following the steps above. 

 

g. Sea level rise elevations will require researching the most recent climate 

change literature.  Any number of sea level rise estimates can be added 

to the BFE allowing visualization of the variation between predictions.    

 

2. Load and Subset Elevation Data: the elevation data used for a flooding study 

should be at a resolution appropriate to the scale of the study.  In the case of the 

Hull pilot study, determining flooding at individual facilities required the use of 

LIDAR data (generally available at a 1-meter resolution) to ensure the necessary 

resolution and accuracy.  Larger study areas could potentially use the 10-meter 

or 30-meter resolution National Elevation Dataset (NED) data available from the 

USGS.  All elevation datasets should be in raster format to facilitate processing in 

ArcView and in the case of LIDAR data should be processed to represent bare 

earth.    

 

a. Check the vertical datum of the elevation dataset by opening the spatial 

metadata in ArcCatalog or checking with the data provider. 

 

i. If the vertical datums of the BFEs and the elevation data are not 

consistent convert them to a single vertical datum using the datum 

conversions at the nearest tide station or using one of NGS’s 

vertical datum conversion programs. 

 

b. Load the raster elevation dataset(s)  

into the ArcView project 

 

c. Use ArcView’s navigation tools to 

 zoom into your area of interest.   

 

d. Right-click on the elevation  

dataset layer in ArcView’s Table  

of Contents and choose  

Data > Export Data. 

 

e. In the ensuing Export Raster Data  

dialog, set the Extent to Data  
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Frame (Current), choose a  

Location, Name and Format for  

the extracted dataset and click  

Save. 

 

f. The extracted dataset will be loaded into  

ArcView.  Turn off or remove the original  

dataset before proceeding. 

 

 

 

3. Creation of Flood Overlays: 

 

a. Enable the Spatial Analyst  

extension in ArcView by  

checking it on in the Tools >  

Extensions dialog.  This will  

load the Spatial Analyst toolbar. 

 

 

 

 

 

 

 

 

 

 

b. From the Spatial Analyst drop-

down menu on the Spatial Analyst 

toolbar, select Options. 

 

c. In the Extent tab set the Analysis 

extent equal to the extent of the 

extracted elevation dataset. 

 

d. In the Cell Size tab set the Analysis 

cell size equal to the cell size of the 

extracted elevation dataset.  
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e. From the Spatial Analyst drop-down menu on the Spatial Analyst toolbar, 

select the Raster Calculator tool.  The extracted elevation dataset will be 

listed in the Layers list.   

 

i. Double-click the 

elevation dataset to 

add it to the 

equation window.   

 

ii. Click the ‘<=’ button 

to add an operator 

to the equation. 

 

iii. Type in the flood 

elevation value (in 

the same units as 

the elevation 

dataset) to add it to 

the equation 

 

iv. Click Evaluate 

 

v. A new true/false raster representing those areas less than the 

flood elevation with ‘1’ and those areas greater than the flood 

elevation with ‘0’ will be loaded into ArcView. The dataset is a 

temporary file and will be called ‘Calculation’. 

 

4. Conversion of Flood Overlays: in order to remove those areas representing dry 

land and any areas of disconnected flooding the raster flood overlay must be 

converted to a feature class. 

 

a. From the Spatial Analyst 

menu select the Convert > 

Raster to Features tool. 

 

b. Set the Input raster to the 

Raster Calculator result. 

 

c. Set the Field equal to ‘Value’ 
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d. Set the Output geometry type to Polygon 

 

e. Check off the option to Generalize lines 

 

f. Define a location and name for the Output features and click OK. 

 

g. A feature class version of the raster flood overlay will automatically be 

loaded into ArcView. 

 

5. Editing of Flood Overlays: two types of polygons must be deleted from the flood 

overlay, those that represent land 

and those that represent areas of 

disconnected flooding. 

 

a. If not already loaded, click 

the Editor Toolbar 

button, , to load the 

Editor toolbar. 

 

b. From the Editor drop-

down menu on the Editor 

toolbar, choose Start 

Editing.  If prompted, 

select the folder 

containing the feature class flood overlay. 

 

c. Right-click on the feature class name in ArcView’s Table of Contents and 

choose Open Attribute Table.   

 

d. From the attribute table’s Options drop-down menu choose the Select by 

Attributes function 

 

e. In the Select by Attributes dialog create a query to select features where 

GRIDCODE = 0 and click apply. 

 

f. This query will select all polygons that have elevation values greater than 

the flood elevation.  When the query is finished press the Delete key to 

delete these polygons from the feature class.   
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g. From the Editor menu, choose the Save Edits option to update the feature 

class permanently. 

 

h. Now that all dry land features have been deleted it should be easy to 

identify those features that represent areas of disconnected flooding.  

These areas will be completely surrounded by dry land. Because they are 

surrounded by areas of higher elevation flooding will be physically unable 

to reach them.  To delete these areas, close the attribute table and 

examine the feature class by zooming and panning.  Select those 

features completely surrounded by dry land with ArcView’s Select 

tool, , and then press the Delete key to remove them from the layer.   

 

i. When all disconnected polygons have been removed choose Stop Editing 

from the Editor toolbar to save the edits and complete the editing process.  

The finalized shapefile will be converted to a KML file in Section 6. 

Pilot Study Results 
 
Base Flood Elevations for the Hull pilot study were determined from the FEMA DFIRM 

for Plymouth County (November 2008).  Table 5.1 contains a summary of the BFE at 

each facility used in the study.  Two facilities, Hull High School and the Municipal Light 

Plant do not fall within the 100-year flood zone. When the Municipal Light Plant facility 

was overlaid with the DFIRMS it was apparent that a portion of the facility did overlap 

with the 100-year flood zone and a BFE was assigned using the overlapping DFIRM 

polygon.  The high school did not overlap with any 100-year zone, though it is 

surrounded by several 100-year zones.   Using the LIDAR elevation data at the site, 

various flood elevations were simulated until the results matched the extents of the 

FEMA 100-year floodplains at the site.  The flood elevation that mostly closely matched 

was 10.5 ft (3.2 m) NAVD88. 
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Table 5.1: Base Flood Elevations at Hull Critical Facilities 

Facility 
Base Flood Elevation 

(NAVD88) 

Hull High School 10.5 ft (3.2 m) 

Hull Memorial School 10.0 ft (3.05 m) 

WWTP 13.0 ft (3.96 m) 

Scully Senior Center 10.0 ft (3.05 m) 

Allerton Post Office 10.0 ft (3.05 m) 

Draper Ave Pump Station  12.0 ft (3.66 m) 

Municipal Light Plant  10.0 ft (3.05 m) 

 
Sea level rise elevations were defined during an initial planning meeting of the Hull pilot 

project team.  At that time four sea level rise elevations were agreed upon, 1 ft (0.3 m), 

1.6 ft (0.5 m), 3.3 ft (1 m), and 9.8 ft (3 m).  These rates were determined so that a 

variety of sea level rise acceleration rates could be represented with the study results. 

 

LIDAR elevation data for the Hull pilot study was provided by the Massachusetts Office 

of Coastal Zone Management.  This data was collected between 2005-2007 for the US 

Army Corps of Engineers (USACE) and the National Coastal Mapping Program (NCMP).  

Elevation data was collected in a 0.5 mile swath along the coastline at 1 m spacing and 

processed to create seamless 1 m grids representing bare earth with a horizontal 

accuracy of 3 m and a vertical accuracy of 30 cm.  Because Hull is so narrow complete 

coverage of the town was available. 

 

For each facility, the corresponding LIDAR layer was clipped to the area around the 

facility and the flood overlays were calculated using this subset of data.  Because the 

pilot project visualizes a variety of sea level rise projections with a BFE specific to each 

location, the project team did not want to show projected flood impacts in locations other 

than directly around the critical facilities, which are all publically owned.   

Using the methods described above, each LIDAR dataset was used to calculate five 

flood overlay layers for each critical facility (one for BFE plus each of four sea level rise 

scenarios).  These flood overlay layers were then converted to KML files for visualization 

in Google Earth. 
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6. Visualizing Results in Google Earth 

Analysis Steps 
 
To bring flood polygon feature classes into Google Earth for visualization with the 3D 

building models they must be converted to KML files.  KML files can consist either of 

features (vector-based KML files) or of georeferenced images (ground overlay KML 

files).  There are pros and cons to both file types, but for this application the feature 

classes will be converted to vector-based KML files because they provide the best 

format for accurately depicting flood elevations.  Vertical accuracy is critical because the 

flood overlays will be shown in relation to 3D buildings.   

 

Once the individual KML flood layers are created, they will be combined into a single 

KML file for each facility and these will be combined into a single network link KML file 

utilizing the KML Regions functionality.  A network link KML file is simply a master file 

that contains links to many additional layers.  Layers can include images, models, and 

other KML files. The networking functionality is useful for splitting one large KML file into 

many smaller and more manageable files.   

 

The KML Regions option loads and draws data only when it falls within the user's view.  

This option allows the flood layers around each facility to be drawn only when the viewer 

gets close to the facility, which is important since flood elevations were based on the 

BFE at each individual facility and may not be valid in surrounding areas.  The FEMA 

flood zones have been added so that the 100-year floodplain for Hull becomes visible as 

the user zooms or pans away from each critical facility.  Also included in the networked 

KML file are predefined viewpoints for each building and labels for each building and 

flood elevation, allowing the user to easily navigate through the results.  

 

Once the data processing is completed ArcView, and a text editor such as WordPad are 

all that is necessary to place the layer into the display software, Google Earth.  In the 

first step ArcView will be used to create vector-based KML files from the flood overlay 

shapefiles.  Next the flood overlay layers will be loaded into Google Earth and organized 

according to facility. Finally a text editor will be used to combine all of the individual KML 

files into a single network link KML file, utilizing the Regions functionality, for final display 

in Google Earth. 
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Create the feature-based KML files: 

 

1. Download and install the Export to KML tool from ESRI’s ArcScripts site.  Follow 

the instructions for installing and loading the tool into ArcView. 

 

2. Open ArcView and load the flood layers to be converted to KML. 

 

3. Symbolize each flood layer as you want it to appear in Google Earth.   

 

a. Right-click on the layer name in ArcView’s Table of Contents and select 

the Properties option. 

 

b. In the Layer Properties 

dialog, select the 

Symbology tab and click 

on the layer’s symbol to 

access its properties. 

 

c. In the Symbol Selector 

dialog, set the Fill Color 

to blue and set the 

Outline Color to ‘no 

color’.  Click OK. 

 

d. Back in the Layer Properties dialog, click the Display tab and set the 

Transparency to 60%.  Click OK. 

 

4. Determine the Water Depth – the KML file will float above the ground surface at 

the specified height, which should be set equal to the local water depth.  To 

determine the water depth at each facility, compare the land elevation with the 

flood elevation. 

 

a. Load the elevation grid(s) and 2D footprints into ArcView. 

 

b. Use the Identify tool, , to determine the land elevation at the foundation 

of each building. 

 

c. Subtract the land elevation from the flood elevation to determine water 

depth at the building foundation. 
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d. Right-click on the flood layer in ArcView’s Table of Contents and select 

the Open Attribute Table option.   

 

e. From the attribute table options drop-down menu, 

select the Add Field option. 

 

f. Using the Add Field dialog create a new field 

called Depth and set the Type to Float.  Click OK 

to create the new field. 

 

g. To populate the Depth field, right-click on the field name in the attribute 

table and select Field Calculator. 

 

h. In the Field Calculator dialog type the water depth in the ‘Depth =’ 

equation box and click OK and close the attribute table.  Each flood 

feature will now be populated with the water depth at the building 

foundation.   

 

5. Click the Export to KML button, , to open the export dialog 

 

a. Select the flood layer from 

the Select the layer to 

export drop down box. 

 

b. Check-on Group and color 

features using the layer’s 

symbology. 

 

c. Leave the Select an 

attribute for labeling 

features option set to 

<NONE>. 

 

d. Set the Select an attribute that represents the height equal to the depth 

field just created. 

 

e. Set the Height attributes units to meters 

 

f. Check-off Extrude features base on the height 
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g. Use the browse dialog to set the name and location of the output KML 

file. 

 

6. Repeat Steps 1 to 5 to create KML files for each flood elevation at each facility 

for input to the final networked KML file. 

 

7. If you would like to add a floating title bar to each flood overlay layer, open each 

flood overlay KML file in a text editor and add the following KLM tags just above 

the <Folder> tag containing the flood geometry.  Change the <href> value to the 

name of the image file to be used as the floating title. 

 

 

 

 

 

8. Open each flood KML file in Google Earth and ensure that it displays correctly.  If 

the flood polygons cover large areas they intersect with the curvature of the 

earth, causing them to disappear in the center.  This issue can be solved by 

splitting large polygons into smaller features (using ArcView’s editing tools), 

which creates more vertices and helps Google Earth to display the polygons 

correctly. 

 

9. With the flood overlay KLM open in Google Earth  right-click on the layer to open 

the Properties dialog and check-off the option to Allow this folder to be expanded.  

This will help to keep the KML file organized by hiding access to the flood 

polygons and floating title.  

 

 

 

 

 

 

 

 

 

 

 



2009-085 / Inundation Visualization 

 41

Organize the flood overlays by facility: 

 

1. Load all the KML flood overlay files for a 

single facility into Google Earth. 

 

2. Right-click on the Temporary Places folder 

and choose the Add > Folder option.   

 

a. Name the folder after the facility. 

 

b. Check-on the options for Allow this 

folder to be expanded and check-off 

Show contents as options (radio button selection).   

 

3. Create a subfolder in the facility folder called “Choose a Flood Elevation” and 

check-on the options for Allow this folder to be expanded and Show contents as 

options (radio button selection). 

 

a. Drag-and-drop each of the flood layers into the “Choose a Flood 

Elevation” folder and place them in the desired order. 

 

4. If specific viewpoints for the facility have been created, 

load those into Google Earth and drag them into the 

facility folder.  The final structure will look something 

like the Scully Senior Center example to the right. 

 

5. Right-click on the new facility folder and choose Save 

Place As.  Save the folder as a KML file and note the location for use in the 

networked KML file. 
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Create a single networked KML files using the Regions functionality: 

 

1. Open the network linked KML template provided (Network_Template.kml) in a 

text editor and save it as a new KML document.  The template contains all the 

KML tags necessary to define a single network link file. 

 

 

 

 

 

 

 

 

 

 

 

 

2. Edit the title 

 

a. Locate the <name> tag directly under the 

<Document> tag and update the text.  This will 

be title of your KML file, as shown in the 

highlighted text. 

 

b. Keep the <open> tag set to 1, ensuring that the 

flood overlay folder will be expanded when it is loaded into Google Earth. 

 

3. Edit the text between the <NetworkLink> tags 

 

a. Set the name of the layer using the 

<name> tag this will be the name of the 

folder containing the network links for a 

single facility, shown the highlighted text. 

 

b. Set the <visibility> tag to 0.  This will 

ensure that the layer is not drawn on initial 

load into Google Earth, which is important since the layer’s visibility is 

location specific. 
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c. The <Region> tag and it’s children set the geographic extents of the 

layer’s visibility: 

 

i. The <LatLonBox> tag and its children allow definition of a 3D 

bounding box which will control visibility.  Set the <north>, 

<south>, <east>, and <west> tags with coordinates that define the 

horizontal extents of the bounding box. 

 

ii. The <Lod> tag and its children define the level of detail of the 

linked file, which controls how the layer fades in and out based on 

zoom level.  Use the following values (for more information about 

setting these values click here): 

 <minLodPixels>512</minLodPixels> 

 <maxLodPixels>-1</maxLodPixels> 

 <minFadeExtent>512</minFadeExtent> 

 <maxFadeExtent>0</maxFadeExtent> 

 

d. The <href> tag defines the actual file to be linked.  Edit this tag to reflect 

the appropriate file name.  If the linked file will reside in the same folder 

as the network link KML file only the file name is necessary, otherwise the 

full file path must be specified. 

 

4. To link additional KML files, copy the <NetworkLink> tag and all of its children 

and paste it below the first <NetworkLink> tag (ensuring that it is above the 

</Document> tag).  Follow steps 3a through 3d to define a new link file. 

 

Pilot Study Results 
 
While ASA has years of experience visualizing flood impacts with Google Earth, the Hull 

pilot project was the first project where actual flood depths were visualized using 3D 

building models.  Bringing this third dimension into the visualization posed some new 

challenges, namely, configuring the custom 3D models so that they interact correctly 

with the transparent flood overlays and ensuring that the flood depths calculated from 

the LIDAR data in ArcView were depicted properly in Google Earth, which has a much 

less accurate terrain model. 

 

When the final flood overlays and 3D building models were initially loaded into Google 

Earth to build the network link KML file it became apparent that the transparent flood 

layers caused the 3D building models to disappear completely under the water surface.  
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Because the flood overlay was 60% transparent it should have allowed the underwater 

portion of the building to show through.  Contact with a Google representative confirmed 

that there is a bug in the Google Earth software that causes 3D models to disappear 

behind vector based KML files. 

 

To solve this issue a variety of workaround solutions were attempted, including:  

 

 Transforming the flood overlays (in vector KML format) to ground overlay KML 

files. 

 Building 3D versions of the building layer from shapefiles to replace the missing 

underwater portions models.  

 Recreating all the flood overlays in SketchUp as 3D models instead of vector 

KMLs.   

 Submitting the 3D models to the Google Earth 3D buildings layer, which does not 

experience the same bug with transparent overlays. 

 

Ground overlay representations of the flooding worked allowed the 3D models to show 

through the transparent water.  However, this method posed a problem because the 

altitude definition for ground overlays is much less accurate than for vector-based KML 

files.  In this case the flood elevations were being rounded to the nearest meter for 

elevations less than one meter and to the nearest half-meter for elevations greater than 

one meter.  Because of the lack of precision this solution was deemed unacceptable as 

all of the vertical accuracy gained by using the LIDAR data would have been lost in the 

conversion to ground overlay based KML file. 

 

Converting the flood overlays into 3D models using SketchUp also allowed the 3D 

building models to show through the transparent flood layer and in this case, vertical 

accuracy was not a problem as SketchUp allows exact definition of heights.  The issue 

with this solution is horizontal accuracy.  Because SketchUp has no real geographic 

reference, some horizontal accuracy is lost when placing the models in Google Earth.   

 

Building non-textured versions of the 3D building models was a very viable solution for 

working around the Google Earth bug and this method was presented to MACZM during 

the final project meeting.  As the flood elevations increase with sea level rise, a grey 

version of the 3D building appears under the water to replace the missing textured 

version of the building.  These non-textured buildings were created from the 2D 

footprints originally constructed in ArcView.  To create 3D buildings, the 2D footprints 

were extruded to each of the flood elevations and saved as a separate vector KML file.  

These KML files were then grouped with the associated flood overlay KML file, so that 
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as each flood overlay was displayed, the associated 3D grey building was automatically 

displayed in place of the missing 3D model.  

 

The final, and ideal, solution was to submit all of the 3D building models to Google Earth 

for inclusion in Google’s native 3D building model layer.  This solution allowed the team 

to use the original vector-based flood KML files and preserve all the texture of the 

buildings underneath the transparent flood layer.  Permission to publish the models to 

Google Earth was granted by the Town Manager of Hull on June 23rd, and the project 

team began submitting models to Google immediately.  The turnaround time for model 

approval is approximately 30 days and by the end of July three models had been 

accepted and feedback for editing the remaining four (outlined in Table 4.2) had been 

provided by Google.  ESS updated the models and resubmitted.  To date, six of the 

seven models have been accepted; the Draper Avenue Stormwater Pump Station is still 

outstanding.    

 

Because the terrain data in Google Earth is highly smoothed, visualizing the results at 

the correct elevation also posed a challenge.  In the flood overlay KML files, each flood 

polygon is represented by X,Y, Z values at each vertex.  The X and Y values provide the 

geographic coordinates of the vertex so that Google Earth knows where to draw the 

polygon and the Z value provides the altitude of the polygon.  How the Z value is 

interpreted by Google Earth depends on the ‘altitude mode’ specified in the KML file.  

There are three standard altitude modes available: clampToGround, relativeToGround, 

and absolute.  The clampToGround option ignores any Z values in the KML file.  The 

relativeToGround option uses the Z value to draw the feature relative to the ground 

elevation.  The absolute option uses the Z value to draw the feature at an elevation 

relative to sea level.   

 

Two approaches were taken to defining the altitudes and altitude modes for the flood 

overlay KML files.  For those facilities on relatively flat ground the Z values were set to 

the depth of water at the facility (determined using the LIDAR data in ArcView)  and the 

altitude mode was set to relativeToGround, but for display purposes the terrain layer in 

Google Earth was turned off so that the ground did not interact with the flood overlays.  

For those facilities set on slopes (the Municipal Light Plant and Draper Avenue Pump 

Station), the Z values were set to the total flood elevation (BFE + sea level rise), 

converted to mean sea level, and displayed in Google Earth with an altitude mode of 

absolute.  In these cases, because of the steep changes in terrain, the Google Earth 

terrain model tends to be less smoothed and thus more accurate.  Once loaded into 

Google Earth the flood overlay Z values were then adjusted until they reached the 

correct depths on the building models.  This manual process was necessary because 
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the reference for the Google Earth terrain is unknown and it was therefore impossible to 

calculate the difference between the Google Earth and LIDAR elevations.   

 

The final images for each flood elevation at every facility are provided in Appendix A to 

this report.  A Google Earth KML file containing all the flood layers has also been 

provided.   
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Appendix A: Critical Facility Figures 
 

 
Figure A-1.  Allerton Post Office, View 1, Base Flood Elevation. 

 

 
Figure A-2.  Allerton Post Office, View 1, Base Flood Elevation plus 1 foot of sea level rise. 
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Figure A-3.  Allerton Post Office, View 1, Base Flood Elevation plus 1.6 feet of sea level 

rise. 
 

 
Figure A-4.  Allerton Post Office, View 1, Base Flood Elevation plus 3.3 feet of sea level 

rise. 
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Figure A-5.  Allerton Post Office, View 1, Base Flood Elevation plus 9.8 feet of sea level 

rise. 
 

 
Figure A-6.  Allerton Post Office, View 2, Base Flood Elevation. 
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Figure A-7.  Allerton Post Office, View 2, Base Flood Elevation plus 1 foot of sea level rise. 

 

 
Figure A-8.  Allerton Post Office, View 2, Base Flood Elevation plus 1.6 feet of sea level 

rise. 
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Figure A-9.  Allerton Post Office, View 2, Base Flood Elevation plus 3.3 feet of sea level 

rise. 

 
Figure A-10.  Allerton Post Office, View 2, Base Flood Elevation plus 9.8 feet of sea level 

rise. 
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Figure A-11.  Waste Water Pollution Control Facility, View 1, Base Flood Elevation.  

 

 
Figure A-12.  Waste Water Pollution Control Facility, View 1, Base Flood Elevation plus 1 

foot of sea level rise.  
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Figure A-13.  Waste Water Pollution Control Facility, View 1, Base Flood Elevation plus 1.6 

feet of sea level rise.  
 

 
Figure A-14.  Waste Water Pollution Control Facility, View 1, Base Flood Elevation plus 3.3 

feet of sea level rise.  
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Figure A-15.  Waste Water Pollution Control Facility, View 1, Base Flood Elevation plus 9.8 

feet of sea level rise.  
 

 
Figure A-16.  Waste Water Pollution Control Facility, View 2, Base Flood Elevation. 
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Figure A-17.  Waste Water Pollution Control Facility, View 2, Base Flood Elevation plus 1 

foot of sea level rise. 
 

 
Figure A-18.  Waste Water Pollution Control Facility, View 2, Base Flood Elevation plus 1.6 

feet of sea level rise. 
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Figure A-19.  Waste Water Pollution Control Facility, View 2, Base Flood Elevation plus 3.3 

feet of sea level rise. 
 

 
Figure A-20.  Waste Water Pollution Control Facility, View 2, Base Flood Elevation plus 9.8 

feet of sea level rise. 
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Figure A-21.  Hull High School, View 1, Base Flood Elevation. 

 

 
Figure A-22.  Hull High School, View 1, Base Flood Elevation plus 1 foot of sea level rise. 
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Figure A-23.  Hull High School, View 1, Base Flood Elevation plus 1.6 feet of sea level rise. 

 

 
Figure A-24.  Hull High School, View 1, Base Flood Elevation plus 3.3 feet of sea level rise. 
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Figure A-25.  Hull High School, View 1, Base Flood Elevation plus 9.8 feet of sea level rise. 

 

 
Figure A-26.  Hull High School, View 2, Base Flood Elevation. 
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Figure A-27.  Hull High School, View 2, Base Flood Elevation plus 1 foot of sea level rise. 

 

 
Figure A-28.  Hull High School, View 2, Base Flood Elevation plus 1.6 feet of sea level rise. 
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Figure A-29.  Hull High School, View 2, Base Flood Elevation plus 3.3 feet of sea level rise. 

 

 
Figure A-30.  Hull High School, View 2, Base Flood Elevation plus 9.8 feet of sea level rise. 
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Figure A-31.  Municipal Light Plant, View 1, Base Flood Elevation. 

 

 
Figure A-32.  Municipal Light Plant, View 1, Base Flood Elevation plus 1 foot of sea level 

rise. 
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Figure A-33.  Municipal Light Plant, View 1, Base Flood Elevation plus 1.6 feet of sea level 

rise. 
 

 
Figure A-34.  Municipal Light Plant, View 1, Base Flood Elevation plus 3.3 feet of sea level 

rise. 
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Figure A-35.  Municipal Light Plant, View 1, Base Flood Elevation plus 9.8 feet of sea level 

rise. 
 

 
Figure A-36.  Municipal Light Plant, View 2, Base Flood Elevation. 
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Figure A-37.  Municipal Light Plant, View 2, Base Flood Elevation plus 1 foot of sea level 

rise. 
 

 
Figure A-38.  Municipal Light Plant, View 2, Base Flood Elevation plus 1.6 feet of sea level 

rise. 
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Figure A-39.  Municipal Light Plant, View 2, Base Flood Elevation plus 3.3 feet of sea level 

rise. 
 

 
Figure A-40.  Municipal Light Plant, View 2, Base Flood Elevation plus 9.8 feet of sea level 

rise. 
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Figure A-41.  Anne M. Scully Senior Center, View 1, Base Flood Elevation. 

 

 
Figure A-42.  Anne M. Scully Senior Center, View 1, Base Flood Elevation plus 1 foot of sea 

level rise. 
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Figure A-43.  Anne M. Scully Senior Center, View 1, Base Flood Elevation plus 1.6 feet of 

sea level rise. 
 

 
Figure A-44.  Anne M. Scully Senior Center, View 1, Base Flood Elevation plus 3.3 feet of 

sea level rise. 
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Figure A-45.  Anne M. Scully Senior Center, View 1, Base Flood Elevation plus 9.8 feet of 

sea level rise. 
 

 
Figure A-46.  Anne M. Scully Senior Center, View 2, Base Flood Elevation. 
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Figure A-47.  Anne M. Scully Senior Center, View 2, Base Flood Elevation plus 1 foot of sea 

level rise. 
 

 
Figure A-48.  Anne M. Scully Senior Center, View 2, Base Flood Elevation plus 1.6 feet of 

sea level rise. 
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Figure A-49.  Anne M. Scully Senior Center, View 2, Base Flood Elevation plus 3.3 feet of 

sea level rise. 
 

 
Figure A-50.  Anne M. Scully Senior Center, View 2, Base Flood Elevation plus 9.8 feet of 

sea level rise. 
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Figure A-51.  Hull Memorial School, View 1, Base Flood Elevation. 

 

 
Figure A-52.  Hull Memorial School, View 1, Base Flood Elevation plus 1 foot of sea level 

rise. 
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Figure A-53.  Hull Memorial School, View 1, Base Flood Elevation plus 1.6 feet of sea level 

rise. 
 

 
Figure A-54.  Hull Memorial School, View 1, Base Flood Elevation plus 3.3 feet of sea level 

rise. 
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Figure A-55.  Hull Memorial School, View 1, Base Flood Elevation plus 9.8 feet of sea level 

rise. 
 

 
Figure A-56.  Hull Memorial School, View 2, Base Flood Elevation. 
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Figure A-57.  Hull Memorial School, View 2, Base Flood Elevation plus 1 foot of sea level 

rise. 
 

 
Figure A-58.  Hull Memorial School, View 2, Base Flood Elevation plus 1.6 feet of sea level 

rise. 
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Figure A-59.  Hull Memorial School, View 2, Base Flood Elevation plus 3.3 feet of sea level 

rise. 
 

 
Figure A-60.  Hull Memorial School, View 2, Base Flood Elevation plus 9.8 feet of sea level 

rise. 
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Figure A-61.  Draper Avenue Storm, View 1, Base Flood Elevation. 

 
Figure A-62.  Hull Memorial School, View 1, Base Flood Elevation plus 1 foot of sea level 

rise. 
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Figure A-63.  Hull Memorial School, View 1, Base Flood Elevation plus 1.6 feet of sea level 

rise 
 

 
Figure A-64.  Hull Memorial School, View 1, Base Flood Elevation plus 3.3 feet of sea level 

rise 
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Figure A-65.  Hull Memorial School, View 1, Base Flood Elevation plus 9.8 feet of sea level 

rise 
 

 
Figure A-66.  Draper Avenue Storm, View 2, Base Flood Elevation. 
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Figure A-67.  Hull Memorial School, View 2, Base Flood Elevation plus 1 foot of sea level 

rise 
 

 
Figure A-68.  Hull Memorial School, View 2, Base Flood Elevation plus 1.6 feet of sea level 

rise 
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Figure A-69.  Hull Memorial School, View 2, Base Flood Elevation plus 3.3 feet of sea level 

rise 
 

 
Figure A-70.  Hull Memorial School, View 2, Base Flood Elevation plus 9.8 feet of sea level 

rise 
 


